# Getting Started with WebEx Training Center

## About this guide

This guide introduces you to Training Center and provides basic information about using its many features. For more information about using these features, refer to the online Help on your Training Center Web site.

Refer to the table below to locate the information you need. Feature descriptions and step-by-step procedures are grouped under the larger training session tasks you are performing, such as scheduling a training session, sharing information, or housekeeping and management tasks, such as muting and unmuting microphones.

<table>
<thead>
<tr>
<th>Set up tasks</th>
<th>Scheduling tasks</th>
<th>Sharing information</th>
<th>Interacting with attendees</th>
<th>Managing training sessions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Learn about your account, Training Manager, and other features............... 2</td>
<td>Learn about scheduling a training session and how to set up an Instant training session ............ 5</td>
<td>Review ways of sharing documents, applications, Web browsers and your desktop .................. 13</td>
<td>Enrich your training session using video, chat, and other tools ........ 23</td>
<td>Assign and remove privileges, mute attendees’ microphones and use other tools to control your training session .......... 42</td>
</tr>
</tbody>
</table>

**Highlights:**
- Your user account ................. 2
- Logging in ..................................... 2
- Training Manager .................. 3
- Finding your session ........... 4
- Joining a training session ........ 4

**Highlights:**
- Types of training sessions ......... 5
- Scheduling a training session .... 6
- Adding tests .......................... 10
- Scoring tests ........................ 12
- Starting an instant training session 13

**Highlights:**
- Sharing options ...................... 14
- Sharing documents .................. 15
- Sharing software (applications, browsers, desktops) .................. 19
- Transferring files ................... 22
- Recording a training session ........ 22

**Highlights:**
- Sending chat .......................... 32
- Using Q & A .......................... 32
- Hands-on Lab ......................... 34
- Breakout sessions .................. 36
- Teleconferencing ................... 36
- Using video .......................... 41
- Polling participants ............... 42
- Participant roles ..................... 42

**Tools you can use:**
- Session Calendar ..................... 4

**Tools you can use:**
- Test Library .......................... 11

**Tools you can use:**
- Annotation tools ..................... 16
- View tools .................................. 17
- UCF for multimedia ..................... 18

**Tools you can use:**
- Panel resizing ......................... 23
- Right-click menu ....................... 31
- Video ..................................... 41

**Tools you can use:**
- Icons on the Participants panel .................. 30
- Usage reports ........................... 46

### Tools you can use:
- Session Calendar
- Test Library
- Annotation tools
- View tools
- UCF for multimedia
- Panel resizing
- Right-click menu
- Video
- Icons on the Participants panel
- Usage reports

### Highlights:
- Your user account
- Logging in
- Training Manager
- Finding your session
- Joining a training session

### Tools you can use:
- Session Calendar
- Test Library
- Annotation tools
- View tools
- UCF for multimedia
- Panel resizing
- Right-click menu
- Video
- Icons on the Participants panel
- Usage reports

### Highlights:
- Types of training sessions
- Scheduling a training session
- Adding tests
- Scoring tests
- Starting an instant training session

### Tools you can use:
- Session Calendar
- Test Library
- Annotation tools
- View tools
- UCF for multimedia
- Panel resizing
- Right-click menu
- Video
- Icons on the Participants panel
- Usage reports

### Highlights:
- Sharing options
- Sharing documents
- Sharing software (applications, browsers, desktops)
- Transferring files
- Recording a training session

### Tools you can use:
- Annotation tools
- View tools
- UCF for multimedia
- Panel resizing
- Right-click menu
- Video
- Icons on the Participants panel
- Usage reports

### Highlights:
- Sending chat
- Using Q & A
- Hands-on Lab
- Breakout sessions
- Teleconferencing
- Using video
- Polling participants
- Participant roles

### Tools you can use:
- Annotation tools
- View tools
- UCF for multimedia
- Panel resizing
- Right-click menu
- Video
- Icons on the Participants panel
- Usage reports
Set up tasks

- Obtaining a user account ......................................................... 2
- Logging in and out ............................................................... 2
- If you forget your password .................................................... 2
- Setting up Training Manager for Windows .................................. 3
- System requirements ............................................................. 3
- Browsing the Session calendar ............................................... 4
- Joining a training session ....................................................... 4

Obtaining a user account

Once you obtain a user account, you can host training sessions using your training session service. You need not obtain a user account to attend training sessions.

You can obtain a user account in one of two ways:

- The site administrator for your Training Center Web site can create a user account for you.
- If your site administrator has made the signup feature available, you can sign up for an account on your Training Center Web site at any time.

To obtain a user account using the signup feature:

1. Go to your Training Center Web site.
   
   Your address for your site is usually in the following format:
   
   `<your_company>.webex.com`

2. On the navigation bar, expand Set Up.

3. Click New Account.
   
   This option is available only if your site has the self-registration feature.

4. Provide the required information, and then click Sign Up Now.

Logging in and out

You must log in to your Training Center Web site to schedule and start your training sessions and access your account features. Your site administrator provides you with your user name and default password for your account.

**Note** You do not need to log in to your site to attend a training session, unless the training session host specifies that all attendees must have a user account.

To log in to Training Center:

1. Go to your Training Center Web site.
   
   The address for your site is usually in the following format:
   
   `<your_company>.webex.com`

2. On the navigation bar, click Log In.

3. Provide your user name and password.

4. Optional. To automatically log in to Training Center whenever you access it, click the Save my user information for automatic login check box.

5. Click Log In.

To log out from Training Center:

To log out from your Training Center Web site, on the navigation bar at the top of the page, click Log Out.

If you have forgotten your user name or password

If you have forgotten either your user name or password, you can quickly obtain it.
To obtain your user name or password:

1. On the navigation bar, click Log In.
2. On the Log In page, click Login Assistance.
3. Provide your email address, and then click OK.

Your Training Center Web site immediately sends you an email message containing your account information.

Setting up Training Manager for Windows

Training Manager is a software program that you install on your computer and use when participating in a training session. Training Manager provides the options that you use to share information—such as presentations and applications—send chat messages, send and receive live video, record a training session, and so on.

The Training Manager software provides the workspace for your training session.

System requirements

Your system must meet these requirements for installing Training Manager for Windows:

- Microsoft Windows 2000 or XP
- Intel x86 (Pentium 400 MHz +) or compatible processor
- 32 MB RAM (64 MB recommended)
- Microsoft Internet Explorer 6 or later, Mozilla 1.6 or later, Netscape Communicator 7.x, Firefox 1.0 or later
- JavaScript and cookies enabled on the Web browser
- 56K or faster Internet connection

**Important**

If you want to share a presentation that was created using Microsoft PowerPoint 2002 for Windows XP, an Intel Celeron or Pentium 500 MHz or faster processor is highly recommended. However, you cannot share other types of presentation or documents unless you either:

- Sign in to your computer as an administrator before starting or joining a training session for the first time, or
- Have a Windows 2000 administrator set up your computer for you.

Subsequently starting or joining a training session does not require administrator privileges.

To set up Training Manager for Windows:

1. On the navigation bar, expand Set Up, and then click Training Manager.

   The Set Up page appears.

2. Click Set Up.

3. If a security dialog box appears, do one of the following:

   - If you are installing Training Manager on Microsoft Internet Explorer, click Yes.
   - If you are installing Training Manager on Netscape Navigator, click Grant.

   Setup continues. A progress message box appears, indicating the progress of setup.

   Once setup is complete, the Setup Complete page appears.

4. Click OK.

   You can now start, schedule, or join a training session.
Browsing the Session Calendar

The Live Sessions page includes a training session calendar, which provides upcoming, daily, weekly, and monthly views of all scheduled or in-progress training sessions on your site, as well as a list of all training sessions being hosted on the current date. Using the calendar, participants can

- search for a training session
- obtain information about a training session
- register for a training session
- join a training session

The following figure shows the **Upcoming** view of the Live Sessions page.

<table>
<thead>
<tr>
<th>Today</th>
<th>Upcoming</th>
<th>Daily</th>
<th>Weekly</th>
<th>Monthly</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Date</th>
<th>Starting Time</th>
<th>Topic</th>
<th>Presenter</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>5/24/05</td>
<td>1:05 pm</td>
<td>recurring weekly 1 Instance AM 1 hr</td>
<td>Indra B.</td>
<td>Registration</td>
</tr>
<tr>
<td>5/24/05</td>
<td>8:15 pm</td>
<td>recurring Weekly_11:56 ahead 1 hr</td>
<td>Fern Host</td>
<td>Not started</td>
</tr>
<tr>
<td>5/24/05</td>
<td>8:15 pm</td>
<td>First Monthly 1 at every 1 month 1 day</td>
<td>Fern Host</td>
<td>Not started</td>
</tr>
<tr>
<td>5/24/05</td>
<td>8:30 pm</td>
<td>recurring Monthly 1st Friday of every 1 month</td>
<td>Fern Host</td>
<td>Not started</td>
</tr>
<tr>
<td>5/25/05</td>
<td>1:00 pm</td>
<td>TC Service Team meeting 5/25/05</td>
<td>Shikha Mathur</td>
<td>Not started</td>
</tr>
<tr>
<td>5/27 - 7/11/05</td>
<td>8:15 pm</td>
<td>recurring Multiple Weekly 5th Tuesday 1 day</td>
<td>Fern Host</td>
<td>Not started</td>
</tr>
<tr>
<td>5/16/05</td>
<td>1:00 pm</td>
<td>text</td>
<td>Test User</td>
<td>Not started</td>
</tr>
<tr>
<td>5/16/05</td>
<td>1:00 pm</td>
<td>text</td>
<td>Test User</td>
<td>Not started</td>
</tr>
</tbody>
</table>

- more session dates are available

Joining a training session

If a training session host invites you to a training session via email, the invitation email message will include information about the training session, instructions for joining the voice conference, and a link that you can click to join the training session.

This example of a training session invitation shows the level of detail included:

```
Hello Justin David,

Dave has invited you to attend a training session on the Web as an attendee, using WebEx:

**Topic:** Product Orientation
**Date:** Friday, March 24, 2005
**Time:** 12:45 PM, Pacific Standard Time (GMT -08:00, San Francisco)
**Session Number:** 60356656
**Training session password:** 625456
**Teleconference:** Call 1-408-804-1700 (Tollfree in US/Canada)

Please click the following link to see more information about the training session, including its agenda, or to join the session.


To contact Dave, send a message to this address: david@webex.com

http://www.webex.com
We're getting ready for training this Thu.
```

**Tip**

A training session invitation may also include a link that you can click to add the training session to any calendar program that supports the iCalendar format, such as Microsoft Outlook or Lotus Notes.
You can also join a training session from an instant message, directly from your Training Center Web site or from the host's Personal Meeting Room page. The steps for joining a training session from your site differ, depending on whether the training session is listed or unlisted—that is, whether or not the training session appears on the public training session calendar and the host's Personal Meeting Room page.

Once you join a training session, instructions for joining the voice conference automatically appear on your screen. This illustration shows sample instructions for a call-in teleconference:

To join a training session from an invitation email or instant message:

1. Click the link in the message to join the training session.
2. On the Session Information page that appears, click Join Now.

Scheduling tasks

- Types of training sessions ................................................................. 5
- Scheduling the training session ......................................................... 6
- Adding a test to the training session ................................................. 10
- Scoring and grading tests ............................................................... 12
- Starting an Instant Session ............................................................ 13

Types of training sessions

Using Training Center, you can set up a scheduled, instant, or audio only training session. When setting up any type of training session, you can specify that it is either listed or unlisted.

Notes

- To participate in a training session, you must use Training Manager. If you have not yet set up Training Manager on your computer, you can do so before joining a training session to avoid a delay. Otherwise, once you join a training session, your Training Center Web site automatically sets up Training Manager on your computer. For more information about setting up Training Manager on your computer, see “Setting up Training Manager for Windows” on page 3.
- You need not have a user account or log in to your site to join a training session, unless the host has specified that all training session participants must have a user account. You need not have a user account or log in to your site to join a training session.
The following table defines each type of training session.

<table>
<thead>
<tr>
<th>Session Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scheduled</td>
<td>A training session that you schedule for a specific date and time, using the Schedule a Training Session wizard. When scheduling a training session, you can: ■ Specify a recurrence pattern for the training session ■ Schedule and start a training session for another user who has granted you scheduling permission ■ Specify voice conferencing options ■ Send invitations to participants ■ Require attendees to register for a training session, which lets you collect information from attendees and enhances the security of your training session ■ Choose which default training session privileges you want attendees to have ■ Choose which training session options you want to turn on or off, such as chat, video, and so on ■ Let attendees join the training session before its scheduled starting time—that is, before you start it ■ Choose a presentation or document to share automatically once a participant joins the training session</td>
</tr>
<tr>
<td>Instant</td>
<td>An impromptu training session that you set up and start immediately, using the Instant Session page. When setting up an instant session, you can specify voice conferencing options only.</td>
</tr>
<tr>
<td>Audio Only</td>
<td>A training session that is a standalone teleconference.</td>
</tr>
<tr>
<td>Listed</td>
<td>A training session that appears on your Training Center Web site's calendar and your Personal Meeting Room page. Because these pages are publicly accessible, visitors can view lists of training sessions on these pages.</td>
</tr>
<tr>
<td>Unlisted</td>
<td>A training session that does not appear on any pages on your Training Center Web site. To join an unlisted training session, attendees must provide the training session number. Your training session service automatically generates a unique training session number for each training session that you host.</td>
</tr>
</tbody>
</table>

**Scheduling a training session**

When scheduling a training session, you must specify a training session topic and starting time. You can also specify several options to provide security for and to customize your training session.

You can schedule a training session quickly from the Schedule Training Session page. You can click the **Start** button at any time to start your training session.

**To schedule a training session:**

1. Log in to your Training Center Web site.
2. On the navigation bar, expand **Host a Session** to view a list of links.
3. Click **Schedule Training**.
4. Scroll to **Session and Access Information**, enter your information, and make your selections.

**Session and Access Information**

- **Schedule for:** Myself (Required) Copy from...
- **Topic:** [Optional]
- **Set session password:** [Optional]
- **Confirm password:**
- **Tracking Code:**
- **Start Session**

**What you can do here**

- Specify whether you are setting up a training session on someone's behalf and the name of that person.
- Define a topic for the training session.
- Set the training session password, if required.
Specify whether the training session is listed on the training session calendar. To enhance training session security, you can opt not to list the training session on the training session calendar. Choosing **Unlisted** will:

- Hide information about the training session, such as its host, topic, and starting time
- Help prevent unauthorized access to the training session

Select tracking codes, if your administrator has set them up.

Tracking codes may identify your department, project, or other information that your organization wants to associate with your training sessions. Tracking codes can be optional or required, depending on how your site administrator sets them up.

5 Scroll to **Teleconference** and make your selections.

**Teleconference**

Options: □ None
□ WebEx teleconferencing service (for 125 or fewer callers)
□ Attendees call in
□ Attendees receive call back
- Estimated number of callers: 123
□ Teleconferencing Service
□ Integrated VoIP

What you can do here

- Set up a WebEx integrated teleconference with a toll or toll-free number or use a third-party conferencing service.
- Opt to have attendees call in to the conference or have them receive a call back.
- Include an Integrated VoIP conference and a traditional teleconference in your training session.

**Note** You start your Integrated VoIP conference after you start your training session.

To provide audio during a training session, you can use one of the following voice conferencing services:

- **Integrated call-in teleconference**—If your training session service provides toll-free call-in teleconferencing, both a toll-free number and a toll number are available. The toll number allows participants who cannot call the toll-free number—such as participants in countries other than the U.S. or Canada—to join the teleconference.
- **Integrated call-back teleconference**—A teleconference that a participant can join by providing his or her phone number when joining a training session.
- **Third-party or internal teleconference**—You can use any third-party teleconferencing service or internal teleconferencing system, and provide instructions for joining a teleconference when setting up a training session. Your instructions automatically appear in a message box when a participant joins the training session.
- **Integrated VoIP conference**—A voice conference in which participants use computers with audio capability to communicate over the Internet rather than the telephone system.

6 Scroll to **Date and Time** and make your selections.

**Date and Time**

Starting time: May 7, 2005
□ 6:30 am □ 3:00 pm
□ Attendees can join 5 minutes before the start time
□ Attendees can also connect to WebEx teleconference

Occurrence: □ Single-session class
□ Recurring single-session class
□ Multiple-session course

Time zone: GMT-07:00, Pacific Daylight Time (San Francisco)
Estimate duration: 1 hour

What you can do here

- Set the date and time for the training session
- Select the number of minutes before the training session’s starting time during which attendees can join the training session and teleconference.
- Set an occurrence pattern for the training session.
■ Set the time zone in which the training session time will appear on the calendar.
■ Set the duration for the training session.
7 Scroll to **In-session Hands-On Lab** and make your selections.

**In-session Hands-On Lab**

Hands-on Lab sessions allow instructors to prepare lessons or exercises that students can complete on remote computers on which training software is installed. Students can use these remote computers during a training session for hands-on learning and practice.

- You can reserve hands-on lab computers for use within a session on this page. The computers you reserve will be available to you during the entire estimated duration of your session.
- To reserve computers for on-demand use by attendees outside of a live session, go to the **Hands-on Lab** page instead.

What you can do here

- Select whether to use a Hands-on Lab during the training session.
- Check the availability of computers in the Hands-on Lab that you select.
- Select the number of remote computers to reserve during the training session.
8 Scroll to **Registration** and make your selections.

**Registration**

You can require attendees to register for a training session before they can join it. When their registration requests are approved, attendees will receive a unique registration ID in their email. Attendees must use this ID to join the session.

- You must manually register if you want to charge attendees a fee or create a test for the session.

What you can do here

- Specify whether attendees must register to attend a training session.
- If attendees must register, select which information attendees must provide on the registration form.
- Approve registration requests automatically.
9 Scroll to **Invite Attendees** and enter information for the attendees you wish to invite.

**Attendees**

What you can do here

- Invite attendees to your training session, by entering their names and email addresses, or selecting them from your address book.
- Enter the number of attendees.
10 Scroll to **Invite Presenters** and enter information for the presenters you wish to invite.

**Presenters**

What you can do here

- Invite presenters to your training session, by entering their names and email addresses, or selecting them from your address book.
- Enter the number of presenters.
11 Scroll to **Session Options** and make your selections.

**What you can do here**
- Select the training session privileges that attendees have once the training session starts. You can allow attendees to:
  - Save, print, or annotate any shared documents, presentations, or whiteboards that appear in their content viewers.
  - View the list of training session participants.
  - Navigate independently through pages, slides, and whiteboard displayed in their content viewer.
- Select which options, such as chat, video, and recording, are available during the training session.
- Require attendees to have an account on your Training Center Web site.
- Specify a URL destination that appears after the training session ends.
- Specify whether attendees can share UCF rich media files.
- Specify alerts that play when a participant joins or leaves the teleconference, if you use integrated teleconferencing.
- Include a message that appears when attendees join the training session.

**Note** A presenter can change the default privileges for all attendees or individual attendees at any time during a training session.

12 Scroll to **Email options** and make your selections.

**What you can do here**
- Select which invitation, update, registration, or reminder emails to send to attendees, presenters, or the host.
- Modify invitation, update, registration, or reminder emails.
- Select when to send the reminder emails.

13 Scroll to **Session Information** and make your selections.

**What you can do here**
- Type an agenda or a description, which the attendees can view before the training session starts.
- Upload a photo to the Session Information page.
- Automatically show a document or presentation to participants once they join the training session.
Select whether the Quick Start page will appear upon joining a training session or a breakout session.

14 Scroll to Course Material to add files for your training session.

Course Material

What you can do here

■ Upload a file to My Folders on your Training Center Web site.
■ Publish course material for participants to download prior to the training session.

15 Scroll to Tests.

Tests

What you can do here

■ Ensure that registration is enabled—a requirement if tests will be used during the training session.
■ Learn how to add a test to your training session once it has been scheduled. You can add a test from the confirmation page that appears, or from the Session Information page.

16 Start or schedule the training session:

■ If the training session’s starting time is the current time, click Start to start the training session.
■ If the training session’s starting time is after the current time, click Schedule.

The Session Scheduled page appears, confirming that you set up the training session successfully. You also receive a confirmation email.

Adding a Test

To test attendees, you must add tests to the training session that they will be attending.

Before you can add tests, do the following to turn on the Testing feature:

■ Schedule, but do not start, a session.
■ Require attendee registration for the session.

To require attendee registration, select Attendee Registration when scheduling or updating the session.

To add a test to a scheduled training session:

1 Do one of the following:

■ From the Session Scheduled page, click Add a test.
■ From the Session Information page for the session, click Add New Test.

2 On the Add Test page, select one of the following and click Next:

■ Create a new test
■ Copy an existing test from the Test Library
   Select the test you want to copy from the Test Library and click Next.
■ Import test questions from saved test or poll questionnaire (*.atp or *.wxt file)
   Select the file and click Next.

3 Compose or edit the test, and click Save.
4 Specify delivery options, such as the test date and time limit, and click Save.

The Manage Test page appears. The following figure shows an example of the Manage Test page.
To return to the Session Information page, click Done.

Follow the same instructions to add multiple tests to a session.

To create a test:
1. Do one of the following:
   - On the Test Library page, click Create New Test.
   - On the Session Information page, click Add New Test. Select Create a new test, and click Next.
     The Create Test page appears.

2. Specify the following:
   - Test title and description
   - Maximum score — Select the check box and type the score in the text box to specify the maximum score an attendee can receive.
   - Grade — Select the check box to assign a grade based on the attendee’s scores. Click the Specify Grades link to specify a grading scale.
   - Display question — Select one of the following:
     - All questions in one page
     - One question per page

3. Click the Insert Question link to add a question or instructions to the test. The Add Question window appears.

4. Click the Question Type drop-down list.

5. In the drop-down list, do one of the following:
   - Choose Instructions to add instructions in the beginning of the test, and click Save.
   - Choose one question type, compose the question, specify the correct answers, and click Save.

6. Follow the same instructions to add additional questions to the test.

7. In the Scoring Panel area for each question, specify a score for the correct answer and optionally type scoring guidelines or comments for the person who will score the test.

8. To rearrange questions, click the Move Up or Move Down links. To edit a question, click Edit.

9. Click Save.

To add a test from the Test Library:
1. Do one of the following:
   - From the Session Scheduled page, click Add a test.
   - On the Session Information page, click Add New Test.

2. Select Copy an existing test from the Test Library, and click Next.
   The Select from Test Library page appears.

3. Select a test and click Next.
   The Edit Test page appears.

4. Make any changes if necessary and click Save.

5. Specify test delivery options and click Save.
   The Manage Test page appears.
6 Make any changes if necessary and click **Done**.

The Session Information page appears, with the title of your test included in the Title section.

**To start an in-session test:**

1 After the session starts, choose **Testing** in the drop-down list on the Participants panel.

2 Select the title of the test, and then click **Launch for All**.

3 On the page that appears, click **Start Test**.

**Scoring and grading answers for a test**

Training Center automatically checks attendees' answers against the correct answers you specified when creating the test and then scores the results. If a test contains essay or fill-in-the-blanks questions, you must manually review and score the test. A complete score is unavailable until you finish scoring the essay or fill-in-the-blanks questions.

**To score the answers for a test:**

1 From the Session Information page, in the Test section, select the test title and click **View**.

The Manage Test page appears.

2 In the Student Answers section, click **View and Score Answers**.

The Submitted Tests page appears. This page lists attendees who have submitted their tests and attendees who have received their scores and grades, if assigned. You can also view the questions and grading scale, if specified.

<table>
<thead>
<tr>
<th>Student Name</th>
<th>Email</th>
<th>Date &amp; Time Submitted</th>
<th>Score</th>
<th>Grade</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gordon Ford</td>
<td><a href="mailto:gordonf@webex.com">gordonf@webex.com</a></td>
<td>6/6/03 11:30 am</td>
<td>Score Answers</td>
<td></td>
</tr>
<tr>
<td>Jenny Parker</td>
<td><a href="mailto:jennip@webex.com">jennip@webex.com</a></td>
<td>6/6/03 9:54 am</td>
<td>95</td>
<td>A</td>
</tr>
<tr>
<td>Eric France</td>
<td><a href="mailto:ericf@webex.com">ericf@webex.com</a></td>
<td>6/6/03 2:00 pm</td>
<td>80</td>
<td>B</td>
</tr>
<tr>
<td>Cynthia King</td>
<td><a href="mailto:cynthiak@webex.com">cynthiak@webex.com</a></td>
<td>6/6/03 11:50 am</td>
<td>90</td>
<td>C</td>
</tr>
<tr>
<td>Cathy Lee</td>
<td><a href="mailto:cathyl@webex.com">cathyl@webex.com</a></td>
<td>6/6/03 1:05 am</td>
<td>100</td>
<td>A</td>
</tr>
<tr>
<td>John Smith</td>
<td><a href="mailto:johns@webex.com">johns@webex.com</a></td>
<td>6/6/03 3:23 pm</td>
<td>Score Answers</td>
<td></td>
</tr>
<tr>
<td>Diana Liang</td>
<td><a href="mailto:dianal@webex.com">dianal@webex.com</a></td>
<td>6/6/03 5:00 pm</td>
<td>95</td>
<td>B</td>
</tr>
</tbody>
</table>

Total submitted tests: 7

3 To score an attendee's test, click the **Score Answers** link for the attendee or click the attendee's name.

The Score Submitted Answers page appears. All answers, except for essay questions, are automatically scored. A partial score appears in the **Results** area. Although fill-in-the-blanks answers are scored automatically, you may want to review them and change the scores, if necessary.

4 Review the essays or fill-in-the-blanks answers that need manual scoring, and specify the scores for the essays.

- To quickly go to a question that needs manual scoring, go to the **Unscored questions** section, choose a question in the drop-down list, and click **Go**.

- To change the score for a fill-in-the-blanks answer, select **correct** or **incorrect** for the question. Clicking **Save** updates the score.

5 Optionally type comments for the attendee.

6 Click **Save** to update the score or your comments.
The test results are updated on the View Test Results page. If you have specified to send grade reports to attendees, the attendee receives the update via email.

Starting an Instant Session

You can start a training session at any time, without the need to schedule it first. When starting an instant training session, you can also set up an integrated voice conference. Once you start the training session, you can send invitation email messages to attendees, if necessary.

To start an Instant Session:

1. Log in to your Training Center Web site.
2. On the Training Center navigation bar, expand Host a Session, and then click Instant Session.
3. Specify information about the training session.
4. Click Start Session.
5. Optional. Send invitations to your training session in one of the following ways:
   - On the Participant menu, point to Invite, and then choose By Email.
   - On the Participants panel, click the Invite button, and then enter an email address on the window that appears.

Sharing — the core of your training session

- Sharing options ................................................................. 14
- Sharing documents and presentations .................................. 15
- Accessing tools for sharing ................................................ 15
- Annotation tools .............................................................. 16
- View tools .......................................................................... 17
- Sharing whiteboards ........................................................... 17
- Sharing multimedia in a WebEx training session .................... 18
- Granting sharing privileges .................................................. 18
- Sharing software ............................................................... 19
- Sharing your desktop ......................................................... 20
- Sharing a remote computer .................................................. 20
- Tips for sharing software ..................................................... 20
- Transferring files during a training session ............................ 22
- Recording a training session ................................................ 22
# Sharing options

Training Center provides you with a variety of options for sharing information in a training session. The following table describes the advantages and disadvantages among these options.

<table>
<thead>
<tr>
<th>Sharing Option</th>
<th>Advantages</th>
<th>Disadvantages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Presentation and document sharing</td>
<td>■ Is faster and more bandwidth efficient than application or desktop sharing.</td>
<td>■ Does not let you edit the content during the training session.</td>
</tr>
<tr>
<td></td>
<td>■ Is ideal for sharing presentations or documents that you do not want to edit</td>
<td></td>
</tr>
<tr>
<td></td>
<td>during the training session.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Lets you and participants annotate content.</td>
<td></td>
</tr>
<tr>
<td>Application sharing</td>
<td>■ Lets you edit the content of any presentation or document open in the</td>
<td>■ Requires more bandwidth than presentation or document sharing.</td>
</tr>
<tr>
<td></td>
<td>application.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Lets you grant attendees control of the application.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Is ideal for software demonstrations.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Lets you and attendees annotate the application and documents that are open</td>
<td></td>
</tr>
<tr>
<td></td>
<td>in it.</td>
<td></td>
</tr>
<tr>
<td>Desktop sharing</td>
<td>■ Lets you quickly share multiple applications at once.</td>
<td>■ Requires the most bandwidth among sharing options.</td>
</tr>
<tr>
<td></td>
<td>■ Lets you show any part of your desktop, including file directories.</td>
<td>■ Lets an attendee with remote control access any part of your computer and</td>
</tr>
<tr>
<td></td>
<td>■ Lets you grant attendees control of your desktop, access files, and run</td>
<td>modify any files, which may be a security concern.</td>
</tr>
<tr>
<td></td>
<td>applications.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Lets you and attendees annotate your desktop and any applications.</td>
<td></td>
</tr>
<tr>
<td>Web browser sharing</td>
<td>■ Lets you guide attendees to various Web pages and sites on the Web.</td>
<td>■ Does not display media effects or transmit sounds on Web pages.</td>
</tr>
<tr>
<td></td>
<td>■ Lets you grant attendees control of your Web browser.</td>
<td>■ Does not let attendees interact with Web pages independently.</td>
</tr>
<tr>
<td></td>
<td>■ Lets you and attendees annotate Web pages.</td>
<td></td>
</tr>
<tr>
<td>Web content sharing</td>
<td>■ Displays media effects and transmits sounds on Web pages.</td>
<td>■ Does not let you guide participants to other Web pages.</td>
</tr>
<tr>
<td></td>
<td>■ Lets attendees interact with Web pages independently.</td>
<td></td>
</tr>
</tbody>
</table>
Sharing documents and presentations

You can share one or more presentations or documents you have created using word processing, presentation, or graphics programs. Document and presentation sharing is ideal for presenting information that you do not need to edit during the training session, such as a slide presentation.

Attendees view the shared document or presentation in their content viewers. They do not need to have the applications used to create the documents available on their computers. Attendees can also view any animation and transition effects on shared Microsoft PowerPoint slides.

Once a training session starts, you can open a document or presentation to share. You do not need to select it or “load” it before the training session.

While sharing a document or presentation, you can:

■ Make annotations
■ Use a pointer to emphasize text or graphics
■ Save it to a file
■ Print it
■ Display it at various magnifications, in miniature (thumbnails), and in a full-screen view
■ Synchronize all participants’ displays with the display in your content viewer

At any time during a training session, you can grant attendees privileges that allow them to annotate, save, print, and display different views of shared presentations or documents.

To share a document or presentation:

1. On the Share menu, choose Presentation or Document. The Share Presentation or Document dialog box appears.
2. Select the document or presentation that you want to share.
3. Click Open.

Tip  For tips that can help you to share documents and presentations more effectively, see “Tips for sharing software” on page 21.

Accessing tools for sharing

As you start sharing documents and applications during your training session, tools are available at your fingertips.

In this example, the host has opened a presentation to share with training session participants.

Notice the changes in the window. You now have access to:

■ Annotation tools for highlighting and referring to elements in the presentation or application you are sharing
- View tools for displaying document and presentations in different ways, such as showing thumbnails of the pages
- Previous and Next buttons, for moving around in a document
- Viewer tabs, which appear for each open document or whiteboard—you can rename or change the order of the tabs by right-clicking each tab’s name

### Annotation tools

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pointer</td>
<td>Lets you point out text and graphics on shared content. The pointer displays an arrow with your name and annotation color. To display the laser pointer, which lets you point out text and graphics on shared content using a red “laser beam,” click the downward-pointing arrow. Clicking this button again and then clicking the Close button turns off the pointer tool.</td>
</tr>
<tr>
<td>Text</td>
<td>Lets you type text on shared content. Attendees can view the text you have entered after you type it and click your mouse in the content viewer, outside the text box. To change the font, on the Edit menu, choose Font. Clicking this button again and then clicking the Close button turns off the text tool.</td>
</tr>
<tr>
<td>Line</td>
<td>Lets you draw lines and arrows on shared content. For more options, click the downward-pointing arrow. Clicking this button again and then clicking the Close button turns off the Line tool.</td>
</tr>
<tr>
<td>Rectangle</td>
<td>Lets you draw shapes, such as rectangles and ellipses on shared content. For more options, click the downward-pointing arrow. Clicking this button again and then clicking the Close button turns off the Rectangle tool.</td>
</tr>
<tr>
<td>Highlighter</td>
<td>Lets you highlight text and other elements in shared content. For more options, click the downward-pointing arrow. Clicking this button again and then clicking the Close button turns off the Highlighter tool.</td>
</tr>
</tbody>
</table>
### View tools

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Annotation Color</td>
<td>Displays the Annotation Color palette. Select a color to annotate shared content. The Annotation Color palette closes.</td>
</tr>
<tr>
<td>Eraser</td>
<td>Erases text and annotations or clears pointers on shared content. To erase a single annotation, click it in the viewer. For more options, click the downward-pointing arrow. Clicking this button again and clicking the Close button turns off the eraser tool.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard View</td>
<td>Clicking <strong>Standard View</strong> displays the shared content as you would normally view it. To display thumbnails, or miniatures, of shared pages, slides, or whiteboards to the side of the content, click <strong>View Thumbnails</strong>. This tool helps you locate a page or slide quickly. Click <strong>Standard View</strong> to return to normal viewing of the shared content.</td>
</tr>
<tr>
<td>View Thumbnails</td>
<td>Displays shared content in a full-screen view. Helps you to ensure that participants can view all activity on your screen. Also helps to prevent participants from viewing or using other applications on their screens during a presentation. Click <strong>ESC</strong> to return to the content viewer.</td>
</tr>
<tr>
<td>Full-Screen View</td>
<td>Displays shared content in a full-screen view. Helps you to ensure that participants can view all activity on your screen. Also helps to prevent participants from viewing or using other applications on their screens during a presentation. Click <strong>ESC</strong> to return to the content viewer.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom In/Zoom Out</td>
<td>Lets you display shared content at various magnifications. Click this button, and then click the page, slide, or whiteboard to change its magnification. For more magnification options, click the downward-pointing arrow.</td>
</tr>
<tr>
<td>Synchronize Displays for All</td>
<td>For presenters, synchronizes all participants' displays with your display. Helps to ensure that all participants are viewing the same page or slide, at the same magnification, as in your display.</td>
</tr>
</tbody>
</table>

### Sharing whiteboards

Sharing a whiteboard allows you to draw objects and type text that all attendees can see in their content viewers. You can also use a pointer to emphasize text or graphics on a whiteboard.

While sharing whiteboard, you can:
- Display it at various magnifications, in miniature (thumbnails), and in a full-screen view
- Save it
- Print it
- Synchronize attendees’ displays with the display in your content viewer

If you grant annotation privileges to attendees, you and attendees can draw and type on a whiteboard simultaneously. You can also allow attendees to save, print, and display different views of shared whiteboards.

#### To share a whiteboard:

On the **Share** menu, choose **Whiteboard**.

When sharing a whiteboard:
- You can add multiple pages to a shared whiteboard. For details, consult the users' guide or online Help.
You can share multiple whiteboards. For each whiteboard that you share, Training Manager creates a new **Whiteboard** tab in the content viewer.

**Sharing multimedia in a WebEx training session**

During a training session, you can share the following types of media files in the content viewer:

- WebEx Recording Format (WRF) files
- video files
- audio files
- Flash movie and interactive Flash files
- Web pages

You can share media files in either of two ways:

- **In a Microsoft PowerPoint presentation**— You can share media files that play on Microsoft PowerPoint slides. Using the WebEx Universal Communications Toolkit, a plug-in for Microsoft PowerPoint, you can insert UCF media objects into your slides. Depending on the options you choose in the toolkit, the media object can either
  - link to a media file that resides on your computer, another computer on your local network, or a remote server
  - contain a media file as part of your presentation file

You can download the Universal Communications Toolkit from your Training Center Web site. For information about using the Universal Communications Toolkit, refer to the guide *Getting Started with WebEx Universal Communications Toolkit*, which is available on your Training Center Web site.

- **As a standalone file**— You can share a media file directly in the content viewer. Training Manager creates a UCF media object for the file automatically, which appears in the content viewer.

  A UCF media object contains options and controls that you can use to display or manipulate its associated media file.

For more information about how UCF works, consult the Training Center User’s Guide or online Help.

**Granting document, presentation, and whiteboard sharing privileges**

By default, only the presenter can share a document, presentation, or whiteboard during a training session. However, you can allow all attendees or individual attendees to share their own presentations or documents or interact with pages, slides, and whiteboards that others share. You can also remove these sharing privileges from attendees at any time.

To specify attendee privileges for shared content in the content viewer:

1. In the Session window, on the **Participant** menu, choose **Assign Privileges**.

   The Assign Privileges dialog box appears.

2. To grant privileges to or remove them from all attendees at once, select **All attendee privileges**.

3. Under **Document**, select or clear the check boxes for any of the following sharing privileges that you want to grant to or remove from all attendees, respectively:
   - Save
   - Print
   - Annotate

4. Under **View**, select or clear the check boxes for any of the sharing privileges that you want to grant to or remove from all attendees, respectively:
   - Attendee list
   - Any document
   - Thumbnails
   - Any page

5. Under **Training session**, select or clear the **Share documents** check box to grant to or remove the privilege from all attendees, respectively.

6. Click **OK**.
Sharing software

When you share software, attendees can follow all actions that you take. You can also annotate the software, or let an attendee annotate it or control it remotely.

You can share these types of software with attendees:

- Applications on your computer
- Your computer’s desktop
- Web browsers
- Remote computers, if you installed the Access Anywhere Agent on the computer

To share an application:


The Share Application dialog box appears, showing a list of all applications currently running on your computer.

2. Optional. To view a list of applications that are installed on your computer, but not currently running, click View Application.

   Use this option to locate an application you want to share, but are not currently using.

3. In the list, select the application that you want to share.

4. Click Share.

   Your application appears in a sharing window on attendees’ screens.

Letting an attendee remotely control shared software

While sharing the following types of shared software, you can let an attendee control it remotely:

- application
- desktop
- Web browser

An attendee who has remote control of shared software can interact with it completely. While an attendee is remotely controlling your shared software, your mouse pointer is inactive. At any time, however, you can reassume control of a shared application and regain use of your mouse pointer.

While you are sharing software, any attendee can send a request to control the software remotely. You can then grant control to the attendee. Alternatively, you can automatically grant control of shared software to any attendee who requests remote control.

You can stop an attendee from remotely controlling shared software at any time.

To let an attendee remotely control shared software:

1. Do either of the following:

   - On the title bar of a window that you are sharing, on the Sharing menu, point to Allow to Control Remotely.
In the lower-right corner of your computer’s desktop, on the Sharing menu, point to Allow to Control Remotely.

2 Select the name of the attendee whom you want to control the software.

Sharing your desktop

Desktop sharing lets you show all training session attendees your computer’s entire desktop—including any applications and windows that are currently open—and all the actions that you take with your desktop.

Desktop sharing can be useful for technical support. For example, you can allow a technical support representative to access your computer and fix a problem as you watch.

While sharing your desktop, you can:

- Control attendees’ views of your desktop.
- Annotate your desktop, using a highlighter tool.
- Let an attendee control your desktop remotely. For example, you can let an attendee edit a document on your computer.
- Let an attendee annotate your desktop remotely.

To share your desktop:

On the Share menu, choose Desktop.

Your desktop appears in a sharing window on attendees’ screens.

To allow an attendee to control your desktop remotely:

1 On the title bar of an application you are sharing, on the Sharing menu, point to Allow to Control Remotely.
2 Select an attendee to control your desktop.

Sharing a remote computer

Remote computer sharing lets you show all training session attendees the computer’s entire desktop or specific applications on it, depending on how you set up the remote computer, and all actions that you take with the computer.

Remote computer sharing can be useful if you want to show attendees an application or file that is available only on that computer.

You can share a remote computer during a training session for which you are the presenter, if:

- You have installed the Access Anywhere Agent on the remote computer.
- You logged in to your Training Center Web site before joining the training session, if you are not the original training session host.

For information about setting up a computer so you can access it remotely, refer to the Access Anywhere User’s Guide.

To share a remote computer:

If you have already set up a computer for Access Anywhere, you can share the computer during a training session.

1 On the Share menu, choose Remote Computer.
Getting Started with WebEx Training Center

The Access Anywhere dialog box appears.

2 Under Remote, select the computer that you want to share.

3 Under Applications, select an application that want to share.

If you set up the remote computer so you can access its entire desktop, the option Desktop appears under Applications.

4 Click Connect.

Depending on the method of authentication that you specified when setting up the computer for Access Anywhere, one of the following occurs:

- If you chose access code authentication, a dialog box appears, in which you must provide the access code that you specified when setting up the remote computer.
- If you chose phone authentication, you receive a phone call at the number that you specified when setting up the remote computer.

5 Do one of the following:

- If you chose access code authentication, type your access code in the box, and then click OK.
- If you chose phone authentication, provide your pass code by following the voice instructions.

Notes

- If you are not the original training session host, you must log in to your Training Center Web site before joining a training session in which you want to share a remote computer. If you are already in a training session, but did not log in to your site, you must leave the training session, log in to your site, and then rejoin the training session.
- If a password-protected screen saver is running on the remote computer, your training session service automatically closes it once you provide your access code or pass code.
- If the remote computer is running Windows 2000, and you must log in to the computer, send a Ctrl+Alt+Del command to the computer.
- If you set up the remote computer so you can access multiple applications, you can share additional applications simultaneously.

Tips for sharing software

These tips can help you share software more effectively:

- To improve the readability of shared software, attendees can use the sizing options on the View menu.
- To improve the quality of attendees’ views of a shared software, ensure that both your monitor display and attendees’ monitor displays are set to the same color depth for example, 16-bit color.
- To improve the performance of software sharing, close all applications that you do not need to use or share. Also, close any applications that use bandwidth, such as instant messaging or chat programs, and programs that receive streaming audio or video from the Web.
Application and Web browser sharing only: Avoid covering a shared application or Web browser with another window on your computer’s desktop. Doing so prevents attendees from viewing the area of the application or browser that the other window covers. Instead, a crosshatched pattern appears in the covered area on attendees’ screens.

You can switch your display between shared software and the Session window. To conserve bandwidth, pause software sharing before you return to the Session window, and then resume sharing once you return to the shared application.

Use a dedicated, high-speed Internet connection when sharing software. Attendees using dial-up Internet connections may notice a delay in viewing or controlling shared software. If you want to share a Microsoft Word, Excel, or other document, you can improve the training session experience for these attendees by using document sharing instead of application sharing.

Transferring files during a training session

As a presenter, you can publish files that reside on your computer during a training session. For example, you can provide attendees with a document, a copy of your presentation, an application, and so on. Published files appear in each attendee’s Session window, allowing them to download the files to their computers.

To transfer files during a training session:

1. On the File menu, choose Transfer.

2. Click Share File.

3. Select the file that you want to publish, and then click Open.

4. Optional. Repeat steps 2 and 3 to publish additional files.

The files appear in the File Transfer window in each participant’s Session window.

Recording a training session

For details about using WebEx Recorder to record on-screen activity in a training session and capture audio in a voice conference, refer to the WebEx Recorder and Player User’s Guide, or the WebEx Network-based Recorder and Player User’s Guide, which are available on the Recording and Playback page on your Training Center Web site. You can access this page from your site’s Support page.
Interacting with attendees

- Working with the panels ...............................................................23
- Panel overview.............................................................................23
- Accessing panel options...............................................................25
- Sharing and full-screen view ........................................................28
- Panel alerts ..................................................................................29
- Sending a chat message..............................................................32
- Using Q & A ..................................................................................32
- Using Hands-on Lab.....................................................................34
- Using breakout sessions ..............................................................36
- Managing a voice conference.......................................................36
- Adding an attendee to a call-back teleconference .......................40
- Starting an Integrated VoIP conference........................................40
- Setting up video............................................................................41
- Polling attendees .........................................................................42

Working with the panels

Using the panels on the right side of the Session window, you can chat with attendees, poll them, send video, and start a question-and-answer or breakout session. These panels are very flexible. You can expand, close, or minimize them quickly and easily. You can also reduce the panels to icons, providing greater space for sharing documents, applications, and other items with training session participants.

Panel overview

Your service selects which panels display initially.

Minimizing and restoring panels

Minimizing and restoring panels has no effect on attendees’ displays.

To minimize a panel:

Click the Minimize icon on the title bar of the panel you want to minimize.
The panel no longer displays. It appears as an icon on the icon tray at the top of the panels.

To restore a minimized panel:
Click its icon on the icon tray.

Minimized panels display as icons.

To restore all minimized panels:
The Restore All command quickly restores all panels you have minimized using the Minimize All command.

1. In the icon tray, click Panels.
   The Select Panel menu displays.

2. On the Select Panels menu, choose Restore All.
   Minimized panels now display.

Expanding and collapsing panels
Expanding and collapsing panels has no effect on the attendees’ displays.

To collapse a panel:
Click the icon in the upper-left corner of a panel to collapse it.
The panel collapses, leaving just the title bar visible.

Use the icon on the left side of the panel title bar to collapse or expand a panel.

The Chat panel is collapsed.
To expand a panel:
If a panel is collapsed (you only can see its title bar), click the icon in the left corner of the title bar to expand it.

Opening and closing panels
You can hide a panel completely so it will not display as an icon on the icon tray. If you close a panel, that panel also closes for attendees. It remains closed for all attendees until you open the panel again.

To close a panel:
1. On the icon tray above the panels, click **Panels**.
   The **Select Panel** menu displays.
2. On the **Select Panel** menu, click to remove the check mark next to the panel that you want to close.
   The panel no longer displays and it is not available as an icon on the icon bar.
   
   ![Panel Options](image)

   Panels without check marks are currently closed.
   Panels with check marks currently display.

   2. On the **Select Panel** menu, click to remove the check mark next to the panel that you want to close.

   If you close the last remaining panel, the large panel area on the right side of the screen disappears. You still have access to the panels through the **Select Panel** menu, available by clicking the **Select Panel** button.

   To open a panel:
   1. On the icon tray above the panels, click **Panels**.
      The **Select Panel** menu displays.
   2. On the **Select Panel** menu, click to place a check mark next to any panel you want to open.
      The panel or panels you selected display. This panel is now available for all attendees.

Resetting the panels
You can return the panels to the display settings that were preset by your service.

1. On the icon tray above the panels, click **Panels**.
   The **Select Panel** menu displays.
2. On the **Select Panel** menu, choose **Reset to Default**.
   The panels return to the display settings originally selected by your service. The size, order, and location of the panels are reset to their original settings.

Accessing panel options
You can easily access the options related to any panel. Simply right-click in the panel title bar to see a menu of commands related to the panel.
### Resizing the content viewer and panels area

You can control the size of the content viewer by making the panel area narrower or wider.

**To change the size of the content viewer and panels:**

Click the dividing line between the content viewer and the panels.

- Drag the line to the left to make the area devoted to the panels wider.
- Drag the line to the right to make the content viewer larger.

### Panel Options

<table>
<thead>
<tr>
<th>Panel</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Participants</td>
<td><strong>Sound Alerts:</strong> Lets you choose a sound to play when a participant:</td>
</tr>
<tr>
<td></td>
<td>■ Joins a training session</td>
</tr>
<tr>
<td></td>
<td>■ Leaves a training session</td>
</tr>
<tr>
<td></td>
<td><strong>Assign Privileges:</strong> Available for only the training session host. Displays the Assign Privileges dialog box, from which you can set privileges for the attendees.</td>
</tr>
<tr>
<td>Chat</td>
<td><strong>Sound Alerts:</strong> Lets you choose the kinds of chat messages for which you want a sound to play. Select a sound from the drop-down list or click <strong>Browse</strong> to find a sound in a different location on your computer.</td>
</tr>
<tr>
<td></td>
<td><strong>Assign Privileges:</strong> Available for only the training session host. Displays the Assign Privileges dialog box, from which you can set privileges for the attendees.</td>
</tr>
<tr>
<td>Video</td>
<td><strong>Single point video:</strong> Lets you view one participant video image.</td>
</tr>
<tr>
<td></td>
<td><strong>Multi-point video:</strong> Lets you view up to four participant video images.</td>
</tr>
<tr>
<td></td>
<td><strong>Video Options:</strong> Lets you adjust the video frame rate, video resolution, and settings for your video capture device.</td>
</tr>
</tbody>
</table>

### Panels and full-screen view

While you are viewing or remotely controlling a shared application, desktop, or Web browser, or viewing a shared remote computer, a presenter can switch between a standard window and full-screen view.

In full-screen view, you access the panels on a floating icon tray located in the lower-right corner of your screen.
To display a panel in full-screen view:
Click its icon on the floating icon tray. For example, to display the Chat panel, click the Chat icon.
The panel “floats” on top of the shared document, presentation, web browser or other shared item. You can drag the panel to move it.

What you can do
Resize individual panels using the Resize Control in the bottom right corner of any floating panel.

To open all panels in full-screen view:
You can have all panels float on top of the shared document, presentation, web browser, or other shared item.
1. On the floating icon tray, click the Select Panel button.
   It is the last button on the floating icon tray.
2. On the Select Panel menu, choose Float All Panels.
   All panels display, even those you had minimized previously.

To organize the floating panels:
As you reopen the panels to chat with a participant, you may find you need to arrange the panels.
1. On the floating icon tray, click the Select Panel button.
   It is the last button on the floating icon tray.
2. On the Select Panel menu, choose Open Right Panel.
   An empty panel appears on the right side of the screen.
   The icon tray now resides at the top of the right panel.
What you can do

Drag any floating panels into this larger panel. Panels resize to fill the space.

- Drag the panel out of the larger panel to “float” it.
- Switch between full-screen view and standard view.

After you return to standard view, all panels (those that are floating and those that you have minimized) return to their preset locations in the right panel.

Sharing documents or software while in full-screen view

In full-screen view, you have access to sharing and viewing options from the Select Panel menu.

If you are sharing a document

If you have already opened several documents, you can switch to share any of these documents.

To display a different document:

1. On the floating icon tray, click the Select Panel button. It is the last button on the floating icon tray.
2. On the Select Panel menu, choose Share.
   You see a list of sharing commands.

3. Select Presentation or Document.
   The Share Presentation or Document dialog box appears.
4. Select the file that you want to share and click Open.

To resize the display of attendees to match your display:

1. On the icon tray above the panels, click the Select Panel button. It is the last button on the floating icon tray.
2. On the **Select Panel** menu, choose **View > Synchronize Views**.

All attendees’ displays now match your display.

**If you are sharing an application**

**To share an application:**

1. On the floating icon tray, click the **Select Panel** button. It is the last button on the floating icon tray.
2. On the **Select Panel** menu, choose **Share > Application**.

   The Share Application dialog displays.

3. Select the application you want to share or click **New Application** to open an application not already running on your desktop.
4. Click **Share**.

**To resize the display of attendees to match your display:**

1. On the floating icon tray, click the **Select Panel** button. It is the last button on the floating icon tray.
2. On the **Select Panel** menu, choose **View > Synchronize Views**.

   All attendees’ displays now match your display.

**If you are sharing a desktop**

**To select another sharing option:**

1. On the floating icon tray, click the **Select Panel** button. It is the last button on the floating icon tray.
2. On the **Select Panel** menu, choose **Share > Desktop**.

**To resize the display of attendees to match your display:**

1. On the floating icon tray, click the **Select Panel** button. It is the last button on the floating icon tray.
2. On the **Select Panel** menu, choose **View > Synchronize Views**.

All attendees’ displays now match your display.

**Panel alerts**

If you have closed, minimized, or collapsed any panels, you will see an alert if a panel you no longer can see requires your attention.

Some reasons for seeing alerts:

- A participant arrives or leaves a training session
- A **Raise Hand** indicator appears in the Participants list
- An attendee sends a chat message
- A poll opens or closes
- Poll answers are received
Alerts for closed panels

If you have closed a panel, the **Panels** button changes color to alert you to a change. For example, if a participant leaves your training session, and you have closed the Participants panel, the Select Panel menu button turns into an alert.

![Alerts for closed panels](image)

Alerts for minimized panels

If you have minimized a panel, the icon representing that panel alerts you of a change.

![Alerts for minimized panels](image)

Alerts for collapsed panels

If you have collapsed a panel, the **Expand/Collapse** icon changes color when you need to pay attention to that panel.

![Alerts for collapsed panels](image)

Understanding the Participants panel

In addition to the list of people currently attending your training session, the Participants panel provides other information about the attendees.

![Understanding the Participants panel](image)
The following table describes the possible indicators that may appear in the participant list.

**Notes**

The Speaker indicator will show which participant is speaking during the training session:

- For an integrated teleconference, the participant name will turn green and the indicator will show sound waves.
- For an Integrated VoIP conference, the indicator will flash.

<table>
<thead>
<tr>
<th>Indicator (host)</th>
<th>Indicator name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Host</strong> indicator</td>
<td>Indicates the training session host.</td>
</tr>
<tr>
<td></td>
<td><strong>Presenter</strong> indicator</td>
<td>Indicates the current presenter.</td>
</tr>
<tr>
<td></td>
<td><strong>Annotation Color</strong></td>
<td>Indicates the color with which the participant can annotate shared content. Participants can select another color with which to make annotations, but their assigned colors in the participant list remain the same.</td>
</tr>
<tr>
<td></td>
<td><strong>Participant Ready</strong></td>
<td>Indicates that the participant’s content viewer is displaying the page, slide, or whiteboard that the presenter is sharing. Can appear in different states, each of which indicates the percentage of the content that has loaded in the participant’s content viewer.</td>
</tr>
<tr>
<td></td>
<td><strong>Speaker</strong> indicator for teleconference</td>
<td>In an integrated teleconference, indicates that the participant is connected to the teleconference and his or her microphone is not muted—that is, the participant can speak.</td>
</tr>
</tbody>
</table>

**Right-clicking the participant’s name**

You can control some of the actions of an attendee directly from the Participants list. Right-click a participant’s name to see a menu of commands related to the participant.
The following table describes the right-click options for the Participants list.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Role To</td>
<td>Select to change the participant’s role to Presenter, Panelist, Attendee, or Host. Options that are not available for a participant will not be selectable.</td>
</tr>
<tr>
<td>Pass Mic</td>
<td>Select to pass or enable a participant’s microphone during an Integrated VoIP session.</td>
</tr>
<tr>
<td>Chat</td>
<td>Select to open the Chat panel, which will have the participant’s name pre-populated in the Send to box.</td>
</tr>
<tr>
<td>Mute</td>
<td>Select to mute a participant during an Integrated VoIP session or teleconference.</td>
</tr>
<tr>
<td>Unmute</td>
<td>Select to unmute a participant during an Integrated VoIP session or teleconference.</td>
</tr>
<tr>
<td>Mute All</td>
<td>Select to mute all participants during an Integrated VoIP session or teleconference.</td>
</tr>
<tr>
<td>Unmute All</td>
<td>Select to unmute all participants during an Integrated VoIP session or teleconference.</td>
</tr>
<tr>
<td>Assign Privileges</td>
<td>Select to set privileges for the attendees. This option is available only for the training session host.</td>
</tr>
</tbody>
</table>

**Sending a chat message to participants**

Chat is useful if you want to:
- Communicate with a participant during a training session that does not include a voice conference
- Send a private message to another participant
- Send brief information to all participants
- Ask a question but do not want to interrupt the presenter

**To send a chat message:**
1. In the Session window, open the Chat panel.
2. Type a message in the Chat box.
3. In the Send to drop-down list, select the recipients of the message.
4. Click Send.

The recipients receive the chat message in their chat viewer.

**Using the Q & A panel**

During a question-and-answer (Q & A) session, you can respond to questions that attendees ask during the training session. A Q & A session not only provides instant text messaging similar to that in Chat, but also does the following:
- Provides a more formal procedure for asking and answering questions in text format
- Automatically groups questions to help you manage the queue, such as quickly identifying questions that you have or have not answered
- Displays visual cues for the status of questions
- Lets you assign questions to the appropriate domain expert on your team
allows you to quickly send a standard response to questions for which you
cannot or do not want to answer immediately.
You can save the questions and answers in a Q & A session to either a text (.txt)
file or a comma-separated/comma-delimited values (.csv) file for future
reference.

**Tip** If you use Q & A during the training session, WebEx recommends that the host or presenter monitor the Q & A panel at all
times during the training session.

### Allowing participants to use Q & A sessions
You can allow or prevent training session participants from using question-
and-answer (Q & A) sessions during a training session.

**To allow or prevent Q & A sessions:**
1. In the Session window, on the Session menu, choose **Session Options**.
The Training Session Options dialog box appears.

2. On the **Communications** tab, do one of the following:
   - To allow participants to use Q & A sessions, select the **Q & A** check box.

**To prevent participants from using Q & A sessions, clear the **Q & A**
check box.

3. Click **Apply**, and then click **OK**.

### Asking a question
You can pose a question to one respondent or selected respondents.

**To ask a question:**
1. In the Session window, in the **Panels** drop-down list, select **Q & A**.

2. Type your question in the **Q & A** box.

3. Optional. To edit your question before sending it, highlight the text and
then right-click the mouse to see editing options.

4. In the **Ask** drop-down list, select the recipients.

5. Click **Send**.
The recipients receive the question in their **Q & A** message boxes.
Answering indicator

When a panelist is typing an answer to a question that no one else has responded to yet, an in-progress indicator displays under that question:

Answering a question

You can answer a question in one of the following ways:

- publicly—the answer appears for all panelists and attendees.
- privately—the answer is sent to all panelists and to the attendee who sent you the question.

To answer a question:

1. In the Session window, in the **Panels** list, select **Q & A**.
2. Select the question from any of the tabs on which you received the question. For example:

<table>
<thead>
<tr>
<th><strong>Q&amp;A</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>My Q&amp;A (1)</td>
</tr>
<tr>
<td>Use</td>
</tr>
</tbody>
</table>

   **John Smith** - 02:32 pm
   Q. Hello, have a question.

3. Do one of the following:

   - To provide a public answer, type your answer in the text box. To edit your answer before sending it, highlight the text and then right-click the mouse to see editing options.
   - To provide a private answer, click **Send Privately**. In the dialog that appears, type your answer in the text box. If you want to save the answer you typed as the standard private answer for all panelists, click **Save**.
4. Click **Send**.

Using Hands-on Lab

Hands-on Lab sessions allow instructors to prepare lessons or exercises that students can complete on remote computers on which training software is installed. Students can use these remote computers during a training session for hands-on learning and practice. Because instructors can control Hands-on Lab sessions, they can maintain an optimized lab environment that is effective, familiar, and consistent.

Starting a Hands-on Lab session

If you have scheduled a Hands-on Lab, you can start the Hands-on Lab session within 15 minutes of the reserved time. The presenter is responsible for managing the Hands-on Lab session.

To start a Hands-on Lab session:

1. In the Session window, on the **Lab** menu, click **Start Hands-on Lab**.

   The Start Hands-on Lab dialog box appears showing which lab and how many computers are reserved.
2 Under **Computer Allocation**, select one of the following:

- **Allow attendees to choose computers.** This allows participants to choose any computer reserved for this session.

- **Assign attendees to computers manually.** When you select this option, participants can only connect to computers assigned to them.

3 Optional. Select the **Record remote computers automatically when participants connect** check box. When you select this option, the **Record** button turns on for all reserved computers. Whenever a participant logs into a reserved computer, the computer records the actions. When the participant logs out, the recording stops.

4 Click **Start**.

   Training Manager contacts the remote computers reserved for your Hands-on Lab session.

   Once the reserved computers are contacted, the Start Hands-on Lab Confirmation dialog box appears.

   The Start Hands-on Lab Confirmation dialog box lists all the computers that are connected to the session and the total attendees in the session.

5 Optional. To limit the number of attendees that can connect to each remote computer, under **Limit Attendees**, select the check box next to **Limit**. Select the number of attendees that you want to limit to each computer.

6 If you selected **Assign attendees to computers manually** in the Start Hands-on Lab dialog box, see To assign computers to participants during a Hands-on Lab session: below.

7 Click **Done**.

---

**Assigning computers during Hands-on Lab sessions**

If you selected **Assign attendees to computers manually** in the Start Hands-on Lab dialog box, you can assign computers to participants from the Start Hands-On Lab Confirmation dialog box, from the Hands-on Lab panel, or from the **Lab** menu.

**To assign computers to participants during a Hands-on Lab session:**

1 From the Start Hands-On Lab Confirmation dialog box, from the Hands-on Lab panel, or from the Session window **Lab** menu, click **Assign Computers**.

   The Assign Computers dialog box appears.

2 Under **Unassigned Participants**, select the name or names of participants that you want to assign to a particular computer. Hold down the **Shift** key to select more than one participant.

3 Under **Computers**, select the computer that you want to assign to the selected participant.

4 Click **Assign**.
5. To give control of the computer to a particular participant, click **Give Control**.

6. When you are finished assigning computers, click **OK**.

7. Click **Done** in the Start Hands-on Lab Confirmation dialog box.

**Asking all to return from labs**

During a Hands-on Lab session, the host can ask all the participants to return from the Hands-on Lab session to the main training session. You can choose to have the participants return immediately, or you can give them a time limit for returning.

**To ask participants to return:**

1. On the **Lab** menu, choose **Ask All To Return**.

   The Ask All To Return dialog box appears.

   ![Ask All To Return](image)

   All participants receive a message asking them to return from Hands-on Lab. The Hands-on Lab sessions end either after 30 seconds or after the time you selected in the **Ask All To Return** dialog box.

2. Do either of the following:
   - Select **within** and choose a time in minutes from the drop-down list. This option gives participants time to finish the tasks that they are working on.
   - Select **immediately and end all sessions after 30 seconds**.

3. Click **OK**.

   A confirmation dialog box appears in which you confirm your request to ask all participants to return from Hands-on Lab.

4. Click **OK**.

   **Ending the Hands-on Lab session**

   The training session host can end the Hands-on Lab sessions at any time.

   **To end a Hands-on Lab session:**

   1. On the **Lab** menu, click **End Hands-on Lab**.

      A confirmation message appears.

   2. Click **OK**.

      The Hands-on Lab session ends for all participants.

   **Note** If you do not manually end the Hands-on Lab sessions, they end automatically when your reservation for Hands-on Lab computers expires. A message appears on your screen 15 minutes before your reservation expires. If the computers have not been reserved for another training session, you can continue to connect to the Hands-on Lab computers. If the host of the new session attempts to connect to the reserved computers, you will be disconnected from the reserved computers.

**Using breakout sessions**

A breakout session is a private content sharing session that includes two or more participants. Breakout sessions allow participants to brainstorm and collaborate in small, private groups that can include presenters or other students, away from the main training session. In a breakout session, small groups interact within a main Breakout Session window using much of the same features, such as sharing whiteboards and applications, as in the main training session. Multiple breakout sessions can occur at once.
Allowing breakout sessions
As a presenter, you can allow panelists or participants to start their own breakout sessions.

To allow breakout sessions:
Do one of the following:
- In the Session window, on the Breakout menu, choose Allow Breakout Sessions.
- On the Breakout Sessions panel, select Allow Breakout Sessions.
- In the Session window, on the Session menu, choose Session Options. On the Communications tab in the Training Session Options dialog box, select Breakout sessions. Then click OK.

The green indicator on the Breakout Sessions panel indicates that breakout sessions are allowed.

The Breakout menu displays the breakout session options for all participants.

Creating a breakout session
Once the presenter allows breakout sessions, you can create your own session.

To create a breakout session:

1. Do either of the following:
   - On the Breakout menu, point to Create Breakout Session.
   - On the Breakout Session panel in the main Session window, click Create Session.

   The Create Breakout Session dialog box appears.

2. In the Topic box, type a topic name.

   Optional for the host, presenter, and panelists only: To include yourself in the breakout session, select the Include myself into this session check box.
3. Under **Participants**, select the check box next to the participants that you would like to invite to the breakout session.

4. In the **Presenter** drop-down list, select **Myself** or the name of the participant whom you want to be the presenter for the session.

5. Optional. To allow participants to join the breakout session without an invitation, under **Participants**, select the check box next to **Let others join the breakout session without invitation**.

6. Optional. To limit the number of participants for the breakout session, under **Participants**, select the check box next to **Limit number of participants who can join this session**. Then, in the box, type or select a number of participants.

7. Click **Create**.

Your breakout session automatically starts, and each invitee receives an invitation to join. The invitee can choose **Yes** or **No**. For breakout session participants, the Breakout Session window appears, listing the names of the presenter and participants of the breakout session in the Breakout Sessions panel. It also displays a chat panel in which participants can chat with other participants. Your name appears in the Breakout Sessions pane in the main Session window.

**Joining a breakout session**

The presenter determines whether a participant can join a breakout session, either by inviting participants, or by allowing participants to join without an invitation.

**To join a breakout session, do one of the following:**

- On the **Breakout** menu, choose **Join Breakout Session** and then the name of the breakout session that you wish to join.
- On the Breakout Session panel, highlight the name of the breakout session that you wish to join and then click **Join Session**.

**Using Integrated VoIP or teleconferencing in breakout sessions**

You can communicate with breakout session participants using Integrated VoIP or teleconferencing. If teleconferencing is set up in the main training session, when you start a breakout session, the call-in or call-back teleconference automatically starts for the breakout session. All the teleconferencing options or Integrated VoIP options that the host set up in the main session apply to the breakout sessions. For more information on Integrated VoIP or teleconferencing, see About managing a voice conference on page 39.

**Notes**

- Participants in a breakout session cannot join a breakout session teleconference until the breakout session presenter joins the teleconference.
- Participants cannot join a teleconference in the main session while connected to a breakout session teleconference.
- If teleconferencing is not available or has not been started for the main session before the breakout session is started, teleconferencing for breakout sessions is disabled also.
- When a participant who is in the breakout session teleconference leaves a breakout session, he or she disconnects from the breakout session teleconference or Integrated VoIP session automatically. The participant returns to the main session and can join the main teleconference or Integrated VoIP session from the Communicate menu.

**Leaving a breakout session**

If you are a participant in a breakout session, rather than the presenter, you can leave a session and return to it later.
To leave a breakout session, do one of the following:

■ Close the Breakout Session Manager window by clicking the Close button in the upper-right corner of the window.
■ On the File menu, choose Leave Breakout Session.
■ On the Breakout Session panel, click Return to Main Session.

Asking all participants to return from a breakout session

As the presenter, you can ask panelists and participants to return from their breakout sessions.

To ask all to return from breakout sessions:

In the Session window, on the Breakout menu, choose Ask All to Return.

All participants in breakout sessions receive a message asking them to return to the main training session. They can choose to leave the session or continue.

Ending your breakout session

If you are the presenter in a breakout session, you can end your session for all participants.

To end a breakout session:

1. Do one of the following:
   ■ Close the Breakout Session Manager window by clicking the Close button in the upper-right corner of the window.
   ■ On the File menu in the Breakout session window, choose End Breakout session.
   ■ On the Breakout Sessions panel in the main Session window, click End Breakout Session.
2. In the dialog box that appears, click Yes.

About managing a voice conference

You have several options for providing audio in your training session. You can set up a phone teleconference, using the integrated WebEx teleconferencing service. With this option, you can either have attendees call a phone number to join the teleconference or have attendees receive a callback. If you prefer, you can use another teleconferencing service provider or an internal teleconferencing service.

When scheduling a training session, you can choose to use Integrated VoIP in addition to, or instead of, a teleconference. This option allows attendees to speak to each other using voice over IP (VoIP)—an Internet-based telephony service—rather than the telephone system. Up to seven participants can have a microphone during an Integrated VoIP conference.

Once you set up a voice conference, you can use conference features to manage your integrated teleconference or Integrated VoIP conference.

During an integrated teleconference, you can:

■ Add an attendee to a call-back teleconference at any time. You can also add someone who is not a training session attendee to the teleconference.
■ Control which participants can speak by muting and unmuting their microphones.

During an Integrated VoIP conference, you can:

■ Set Integrated VoIP options
■ Start an Integrated VoIP conference
■ Mute and unmute your microphone
■ Mute and unmute participants’ microphones
■ End an Integrated VoIP conference
Adding an attendee to a call-back teleconference

Once an attendee joins a training session that includes an integrated teleconference, a dialog box appears in the attendee’s Session window, providing instructions for joining the teleconference. However, if you set up a call-back teleconference, you can add an attendee to the teleconference at any time. You can also add someone who is not a training session attendee to the teleconference.

To add an attendee to a call-back teleconference:

1. On the Participant menu, choose Invite > by Phone.

   The Invite by Phone dialog box appears.

   The Status box indicates that call status is Ready.

2. Type the name of the person whom you want to call in the Name box.

3. Type the attendee’s area or city code and phone number in the Area/City code and Number boxes, respectively.

4. Ensure that the country or region code is that for the country in which the attendee resides. To select a different country or region code, do the following:
   a. Click Country/Region.

   The State box indicates that call status is Ready.

5. Click Call.

   The teleconferencing service calls the attendee. The Status box indicates the status of the call.

   Once the call connects, the Clear button becomes available.

6. To call another attendee, click Clear to reset the status to the Ready state.

7. Once you have finished calling attendees, click Close.

Starting an Integrated VoIP conference

To use an Integrated VoIP conference, your computers must meet the system requirements for Integrated VoIP.

Once you start an Integrated VoIP conference, any attendee whose computer has a supported sound card can join the conference.

To start an Integrated VoIP conference:

1. In the Session window, on the Communicate menu, point to Integrated VoIP.

2. On the menu that appears, choose Start Conference.
The Audio Setup Wizard appears if this is the first time that you have started an Integrated VoIP conference.

3 Follow the instructions in the Audio Setup Wizard to set up audio options.

4 Click OK.

Note these changes:

- The Volume dialog box appears, on which you can adjust the speaker or microphone volume.

- If you are using a headset, a microphone symbol and Speak now appear at the bottom of the Session window. An indicator also appears showing the level of sound as you speak.

- If you are using desktop or laptop speakers and your microphone is unmuted, Press Ctrl to speak appears at the bottom of the Session window.

- A microphone symbol appears to the left of your name in the Participants panel.

The Join Integrated VoIP Session message box appears automatically in the Session window for each attendee whose computer has a supported sound card. Attendees can then choose to participate in the Integrated VoIP conference.

### Setting up video

If a video camera is attached to your computer, you can send live video to training session participants. Live video lets other participants see you, an object under discussion, and so on. All participants can view live video that you send, without the need for video equipment installed on their computers.

To set up video, you must connect a video camera—also called a webcam—to your computer. Once you start or join a training session, Training Manager automatically detects your video camera.

Generally, Training Manager is compatible with any video camera that connects to your computer's USB or parallel port. The quality of the video image can vary, depending on the quality of the video camera that you use. For a list of video cameras that are known to be compatible with your Training Manager software, refer to the Frequently Asked Questions (FAQ) page on your Training Center Web site. You can access this page from your site's Support page.

### Sending live video

If the single-point video option is turned on, only the presenter or another participant selected by the presenter can send live video.

If the multi-point video option is turned on, up to four participants whose computers have a video camera can send video.
**To send live video:**

In the Session window, display the Video panel on the right side of the Session window. For details about using the panels, see Working with the panels on page 23.

Training Manager begins sending live video immediately.

To send live video, you must connect a video camera to your computer. For details, consult the documentation that accompanied your camera.

---

**Polling attendees**

During a training session, you can poll attendees by providing a questionnaire with multiple-choice answers. Taking a poll can be useful for gathering feedback from attendees, allowing attendees to vote on a proposal, and so on.

To take a poll, you must first prepare a poll questionnaire. You can prepare a questionnaire at any time during a training session. Or, to save time during a training session, you can prepare a questionnaire before the training session starts, save it, and then open it during the training session.

Once attendees complete a poll, you can view the results and share them with attendees. You can also save the results of a poll for viewing outside of a training session.

---

**Preparing a poll questionnaire**

During a training session, you can prepare a poll questionnaire that includes multiple-choice answers. Once you complete a questionnaire, attendees can respond to it during a training session.

---

**Managing training sessions**

- Participant roles and privileges .................................................... 42
- Granting privileges to attendees .................................................. 43
- Controlling a training session .................................................... 45
- Inviting attendees to a training session in progress ...................... 45
- Designating a presenter ............................................................... 45
- Transferring the host role ............................................................ 45
- Expelling a participant ................................................................. 45
- Locking and unlocking a training session ..................................... 46
- Ending a training session ............................................................. 46
- Viewing usage reports ................................................................. 46

---

**Participant roles and privileges**

Each participant in an online training session has one of the following roles: host, presenter, panelist, or attendee. These roles determine which options you can use on your Training Center Web site and in Training Manager.

<table>
<thead>
<tr>
<th>Role</th>
<th>Responsibilities and options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>A training session host must have a user account on your Training Center Web site. A host can schedule, start, and control a training session; and assign training session roles to other participants. Initially, the host is also the presenter; however, the host can make any participant the presenter during the training session.</td>
</tr>
</tbody>
</table>
About granting privileges to attendees

Once a training session starts, all training session attendees automatically receive privileges:

- If the host scheduled the training session and specified attendee privileges, attendees receive those privileges.
- If the host scheduled the training session but did not specify attendee privileges, attendees receive the default privileges.
- If the host started an instant training session, attendees receive the default privileges.

You can grant or remove privileges for the following training session activities:

- Document sharing, including privileges for saving, printing, and annotating shared content in the content viewer
- Viewing thumbnails, or miniatures, of pages, slides, or whiteboards in the content viewer
- Viewing any page, slide, or whiteboard in the content viewer, regardless of the content that the presenter is viewing
- Viewing the participant list
- Chatting with participants
- Allowing breakout sessions with participants
- Recording a training session
- Requesting remote control of shared applications, desktops, or Web browsers

Granting attendee privileges during a training session

During a training session, you can grant privileges to or remove them from all attendees at once or an individual attendee.

To specify attendee privileges during a training session:

1. In the Session window, do one of the following:
   - On the Participant menu, choose \textbf{Assign Privileges}.
   - On the Participant panel, right-click a participant’s name, and select \textbf{Assign Privileges}.

   The Assign Privileges dialog box appears.

2. Specify attendee privileges:
   - To grant a privilege to attendees, select its check box.
To grant all privileges to attendees, select the **All attendee privileges** check box.

To remove a privilege from attendees, clear its check box.

3 Click **OK**.

---

**Controlling a voice conference**

**Controlling an integrated teleconference**

During a training session, you can mute or unmute participants’ microphones.

**To mute or unmute specific participants’ microphones:**

In the Participant panel, select the participant and do one of the following:

- Right-click on the participant’s name and choose **Mute** or **Unmute**.
- On the Participant menu, choose **Mute** or **Unmute**.

**To mute or unmute all participants’ microphones:**

Do one of the following:

- Right-click on a participant’s name and choose **Mute All** or **Unmute All**.
- On the Participant menu, choose **Mute All** or **Unmute All**.

---

**Controlling an Integrated VoIP conference**

During a training session, you can start an Integrated VoIP conference, and let up to seven participants speak by passing the microphone to them.

**To start an Integrated VoIP conference:**

On the Communicate menu, point to **Integrated VoIP**, and then choose **Start Conference**.

A message appears on all participants’ screens, asking them to join the conference.

**To let a participant speak in an Integrated VoIP conference:**

In the Participant panel, select the participant and do one of the following:

- Right-click on the participant’s name and choose **Pass Mic**.
- On the Participant menu, select **Pass Microphone**.

---

**Using Integrated VoIP**

If your training session includes an Integrated VoIP conference, you can run the Audio Setup Wizard to ensure that your computer’s audio settings are appropriate for Integrated VoIP.

**To run the Audio Setup Wizard:**

On the Communicate menu, point to **Integrated VoIP**, and then choose **Audio Setup Wizard**.

If you are already participating in an Integrated VoIP conference, the wizard is not available. In this case, end the conference, run the wizard, and then rejoin the conference.

**To join an Integrated VoIP conference:**

On the Communicate menu, point to **Integrated VoIP**, and then choose **Start Conference**.

**To leave an Integrated VoIP conference:**

On the Communicate menu, point to **Integrated VoIP**, and then choose **End Conference**.
Controlling a training session

As a training session host, you can control many aspects of an online training session.

Inviting attendees to a training session in progress

Once you start a training session, you can invite additional attendees to the training session, as well as remind those who you invited, but haven’t yet joined. Each person that you invite receives either an invitation email message or instant message that includes information about the training session—including the password—and a link that the attendee can click to join the training session.

To remind or invite an attendee to a training session in progress:

1. On the Participant menu or from the Invite or Remind participants button on the Participant panel, do one of the following:
   - Point to Remind, choose by Email, and then choose either to send via the session email or from your local email program.
   - Point to Remind, choose by IM, and select a WebEx AIM Pro contact. You can also copy the session information into another IM program.
   - Point to Invite, choose by Email, and then choose either to send via the session email or from your local email program.
   - Point to Invite, choose by IM, and select a WebEx AIM Pro contact. You can also copy the session information into another IM program.
2. Type the attendee’s screen name or email address.
3. Click the appropriate button to send the reminder or invitation.

To designate a presenter:

1. In the Participants panel, select the name of the attendee whom you want to designate as the presenter.
2. Do one of the following:
   - On the Participants panel, click Make Presenter.
   - Right-click the attendee’s name, select Change Role To, and then Presenter.
   - On the Participant menu, select Change Role To, and then Presenter.

Transferring the host role

As a training session host, you can transfer the host role—and thus all control of the training session—to an attendee.

To transfer the host role:

1. In the Participants panel, select the name of the attendee to whom you want to transfer the host role.
2. Do one of the following:
   - Right-click on the participant’s name, select Change Role To, and then Host.
   - On the Participant menu, select Change Role To, and then Host.

Expelling a participant

You can remove, or expel, a participant from a training session at any time.

To expel a participant:

1. In the Participants panel, select the name of the participant whom you want to expel.
2. On the Participant menu, select Expel.
Locking and unlocking a training session

Once you start a training session, you can restrict access to it, or “lock” it. This option prevents anyone else from joining the training session. You can unlock a training session at any time.

To lock a training session:
On the Session menu, choose Restrict Access.

To unlock a training session:
On the Session menu, choose Restore Access.

Ending a training session

Once you end a training session, the Session window closes on all participants’ screens. If the training session includes an integrated voice teleconference, the conference also ends.

To end a training session:
2. In the confirmation message that appears, click Yes.

Viewing usage reports

If your Training Center Web site includes the reports option, you can view the following types of usage reports:

- **Live Training Usage report**—Contains detailed information about each training session that you host, including information about each participant.

- **Access Anywhere Usage report**—Contains detailed information about the computers that you access remotely and your Access Anywhere sessions, if your site or account includes the Access Anywhere option.

- **Recorded Training Access report**—Contains detailed access information about recorded training sessions on your Training Center Web site. This report includes information for each time your recorded session is viewed.

To view a usage report:
1. Log in to your Training Center Web site.
2. On the navigation bar, click My WebEx.
3. Click My Reports.
4. Select the type of report that you want to view.
5. Specify a range of dates for which you want to view a report and how you want data sorted in the report.

Contacting WebEx Communications

Receiving Technical Support

For information about contacting technical support for WebEx Training Center, refer to the Support page on your Training Center Web site.

Providing Feedback to WebEx Communications

WebEx Communications greatly appreciates any feedback that you provide about our products and documentation.

Providing Feedback About Training Center

You can provide feedback to WebEx Communications by sending an email message to feedback@webex.com.

Providing Feedback About This Documentation

If you have comments about WebEx documentation, please send an email message to docs@webex.com.

In your email message, please specify the section to which your comment applies. If you would like to receive a response to your comments, please include your name and contact information in your message.
Index

A
Access Anywhere
and sharing remote computers 20
Usage report, viewing 46
account
logging in 2
logging out 2
password, obtaining if forgotten 2
signing up for 2
adding tests 10
alerts
for closed panels 30
for collapsed panels 30
for minimized panels 30
on panels 29
allowing, breakout sessions 37
annotation color
choosing from palette 17
displaying palette 17
Annotation Color indicator, description 31
annotation tools
annotation color 17
eraser tool 17
highlighter tool 16
line tool 16
overview 16
pointer tool 16
rectangle tool 16
text tool 16
answering questions 34
answers in Q & A session 34
applications
advantages of sharing 14
disadvantages of sharing 14
instructions for sharing 19
tips for sharing 21
Ask to Speak indicator, description 31
assigning computers
in Hands-on Lab 35
attendee role, overview 43
attendees
adding to teleconference 40
expelling from a session 45
granting privileges 18
inviting to a session in progress 45
making presenter 45
remote control of shared software 19
transferring host role to 45
Audio Only training sessions
description 6
B
breakout sessions
allowing 37
asking participants to return from 39
ending 39
leaving 38
methods for starting 37
using Integrated VoIP conferencing 38
using teleconferencing 38
C
calendar 4
chat
overview 32
sending messages 32
sending private messages 32
chat messages
instructions 32
sending 32
closing, panels 25
collapsing, panels 24
comparing, sharing options 14
computers in Hands-on Lab
assigning 35
contacting Technical Support 46
content viewer, resizing 26
controlling
integrated teleconference 44
Integrated VoIP conferences 44
D

desktop sharing
  advantages 14
  disadvantages 14
  overview 20

document sharing
  advantages 14
  disadvantages 14
  overview 15

documents
  instructions for sharing 15
  privileges for sharing 18
  tools for sharing 15

E

ending
  breakout session 39
  training sessions
    instructions 46
  voice conferences 46

eraser tool, for annotations 17

F

feedback, providing to WebEx 46
  files
    allowing participants to download 22
    publishing 22
    transferring to participants during session 22
  floating, panels in full-screen view 27
  full-screen view
    and panels 26
    floating panels 27
  sharing 28

G

grading tests 12
granting privileges, to attendees during a session 43

H

Hands-on Lab
  asking all to return 36
  assigning computers 35
  overview 34
  starting 34

highlighter tool, for annotations 16
host indicator, description 31
host role
  overview 42
  transferring to another participant 45

I

indicators
  Annotation Color 31
  Ask to Speak 31
  Host 31
  Integrated VoIP Participant 31
  Integrated VoIP Speaker 31
  Muted Speaker 31
  Participant Ready 31
  Presenter 31
  teleconference Speaker 31

instant message 45

Instant Sessions
  description 6
  starting 13

Integrated VoIP conferences
  controlling 44
  joining 44
  leaving 44
  setting up computer for 44
  starting 40

Integrated VoIP Participant indicator, description 31
invitation to training session, example 4
inviting attendees, to a session in progress 45

J

joining, training session 5

L

leaving
  breakout session 38
  line tool, for annotations 16
listed training sessions, definition 6
Live Sessions page 4
locking a session 46
logging in, to Training Center 2
logging out, from Training Center 2
media files
  sharing in MS PowerPoint presentation 18
  sharing standalone file 18
  types for sharing 18
minimizing panels 23
multimedia, sharing in meeting 18
Muted Speaker indicator, description 31
muting, microphones in teleconference 44
options
  changing for panels 25
  setting for panels 25
panels
  alerts 29
    when closed 30
    when collapsed 30
    when minimized 30
  closing 25
  collapsing 24
  displaying in full-screen view 27
  expanding 25
  floating 27
  in full-screen view 26
  minimizing 23
  minimizing all 24
  overview 23
  resetting 25
  restoring 24
  restoring all 24
  returning to default settings 25
  setting options 25
Participant Ready indicator, description 31
presentations
  advantages of sharing 14
  disadvantages of sharing 14
  instructions for sharing 15
  overview 15
  privileges for sharing 18
  tools for sharing 15
platform-specific client, setting up for Windows 3
pointer tool
  for annotations 16
poll questionnaire, preparing 42
polling
  overview 42
  preparing questionnaire 42
presentation sharing
  overview 15
presenters
  designating during a session 45
  overview 43
privileges
  for sharing documents, presentations, and whiteboards 18
  granting to attendees 18
  granting to attendees during a session 43
  overview of 42
  removing 43
Q & A message box 33
Q & A sessions
  allowing participants to use 33
  answering questions 34
  asking questions 33
  overview 32
questionnaires
  for polling attendees 42
  with polling feature 42
questions
  answering 34
  asking in Q & A session 33
  asking in Q & A session
  asking 33
recording meetings. See WebEx Recorder and Player User’s Guide.
rectangle tool, for annotations 16
reminding attendees to join 45
remote computer sharing
    overview 20
    starting 20
remote control of software, overview 19
removing
    attendee privileges 43
    participant from a session 45
resetting panels 25
resizing
    content viewer 26
    panels 26
restoring panels 24
roles and privileges, overview 42

scheduled training sessions, description 6
scheduling
    Course Material 10
    Date and Time 7
    Email options 9
    Hands-on Lab 8
    Invite Attendees 8
    Invite Presenters 8
    Registration 8
    Session and Access Information 6
    Session Information (Agenda) 9
    Session Options 9
    Teleconference 7
    Tests 10
scheduling training sessions 6
scoring tests 12
Session Calendar 4
sharing
    accessing tools 15
    in full-screen view 28
    remote computer 20
    tips with shared software 21
    types 14
    types of software 19
    whiteboards 17
sharing a desktop. See desktop sharing.
sharing a remote computer. See remote computer sharing.
sharing applications
    advantages 14
    and remote control 19
    disadvantages 14
    instructions 19
    overview 19
sharing desktops
    advantages 14
    disadvantages 14
sharing documents
    activities 15
    advantages 14
    disadvantages 14
    instructions 15
    overview 15
sharing options, comparison 14
sharing presentations
    activities 15
    advantages 14
    disadvantages 14
    instructions 15
sharing software
    overview 19
    remote control 19
    resolution settings 21
    tips 21
sharing Web browsers
    advantages 14
    disadvantages 14
sharing Web content
    advantages 14
    disadvantages 14
sharing whiteboards
    actions to take 17
    instructions 17
signing up
    for account 2
software
    tips for sharing 21
Speaker indicator
  Integrated VoIP 31
  teleconference 31
starting
  an Integrated VoIP conference 40
  breakout sessions 37
Hands-on Lab 34
remote computer sharing 20
stopping
  breakout session 39
system requirements
  Training Manager 3

T
Technical Support, contacting 46
teleconference
  adding attendees 40
  controlling integrated 44
testing your participants
  scoring and grading tests 12
tests
  adding 10
  scoring and grading 12
text tool, for annotations 16
tools
  for annotating documents and presentations 16
  for sharing documents and presentations 15
Training Center
  logging in 2
  logging out 2
Training Manager
  setting up 3
  system requirements 3
training session invitation, example 4
training sessions
  Audio Only 6
  calendar 4
  expelling participant from 45
  instant 6
  instant, starting 13
  instructions for scheduling 6
  joining 5
  listed 6
  locking and unlocking 46
  scheduled 6
  scheduling 6
types 5
unlisted 6
Training Usage report, viewing 46
transferring files
  to participants 22

U
Universal Communication Format (ucf), for media files 18
unlisted training sessions, definition 6
unlocking, a session 46
unmuting
  microphones in teleconference 44
usage reports, viewing 46
user account
  logging in 2
  logging out 2
  obtaining password if forgotten 2
  signing up for 2

V
video
  overview 41
  quality 41
  sending 41
  setting up 41
video camera
  connecting to computer 41
  supported models 41
view tools
  full-screen view 17
  zoom in 17
  zoom out 17
voice conferences
  call back 40
  overview 39
  See also Integrated VoIP conference
voice over IP (VoIP), overview 39
W

Web browser sharing
  advantages 14
  disadvantages 14
  tips 21

Web content sharing
  advantages 14
  disadvantages 14

whiteboards
  instructions for sharing 17
  privileges for sharing 18
  sharing 17

Z

zooming in, on content 17
zooming out, on content 17